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Introduction

Your Mac is a fantastic tool for enjoying multimedia, and the iLife suite of applications lets
you create and share your own multimedia content with the whole wired world.

iLife ‘09 Portable Genius shows you how to get the most out of the iLife applications. Here's a taste

of what you can do with this book:

Enjoy music and videos in iTunes. Exploit iTunes to the full by setting it and your iPod
to deliver high audio quality, building a powerful, easy-to-use media library, creating
videos that work with iTunes, getting the most out of playlists,and using your iPod or
iPhone to carry files.

Bring your photos into iPhoto. Import your digital photos directly from your digital
camera or a removable memory card — or from another folder on your Mac or your net-
work. Use Image Capture to scan printed photos so that you can use them on your Mac.

Organize, improve, and share your photos. Quickly organize your photos into iPhoto
Events and tag them with keywords so that you can instantly find the photos you want.
Use iPhoto’s new Faces feature to automatically identify the key people in your photos
and the Places feature to organize photos by location. Once you've cropped and adjusted
your photos so that they look exactly as you want them, you can create powerful slide
shows, share your photos with other people on your network or the Internet, or simply use
them to enhance your copy of Mac OS X.

Import your video footage into iMovie. Bring your video clips into iMovie from your
DV camcorder or from your digital camera. Swiftly and effortlessly review your clips, mark
the footage you want to use in your projects, and organize related clips into Events so
that you can retrieve them easily.

Build a movie from your clips. Grasp iMovie’s slick, nondestructive method of handling
edits, and learn when to edit in the Event Browser and when to edit on the Storyboard.



Build the movie on the Storyboard by arranging the clips and editing them to fit. If you
want, add still photos — and enliven them with custom Ken Burns effects.

Finish, polish, and share your movie. Give your movie a professional finish by adding
themes, titles and transitions and creating a custom sound track complete with music
and sound effects.You can then share the movie with friends by creating a file or a DVD
or with the world by posting it to YouTube, your MobileMe Gallery, or your Web site.

Set up a music studio on your Mac. Perhaps the best feature of iLife is the way it packs
a complete music studio into your Mac. As soon as you've connected your musical key-
board and any physical instruments you're using to your Mac, you're ready to start mak-
ing music with GarageBand—or learning to play an instrument or a song with
GarageBand’s help.If your song needs a kick-start, fire up the Magic GarageBand feature

to quickly lay down a backing track that you can play or sing along with.

Record a song. To create a song quickly in GarageBand, you can build tracks out of
loops, changing them so that they exactly meet your needs.You can then add in your
own performances playing either a Software Instrument via your keyboard or a real,
physical instrument such as a guitar or drum kit. You can even create your own custom
Software Instruments to get exactly the sounds you want.

Mix a song and share it. Even the best performance may need editing, and GarageBand
makes it easy to remove mistakes or cut together the best parts of several takes.You can
then mix the song, adjusting the balance, panning, and effects on each track so that it ful-
fils your artistic vision. When the song is finished, you can export it to iTunes; add tags,
lyrics, and artwork there; and finally share the song on the Internet.

Build your own Web site quickly and easily. The best place to showcase the photos,
movies, and music you create with the iLife applications is by reaching a worldwide audi-
ence on the Web.The iWeb application lets you quickly create great-looking Web sites
from your content.You can even add Web widgets such as interactive Google Maps,
AdSense advertisements, YouTube videos, and RSS feeds.

Add blogs and podcasts to your Web site. If you have rapidly changing information
that you need to share, you'll love iWeb's features for adding blogs and podcasts to your
Web site. You create the blog entries in iWeb and the podcasts in GarageBand, and can
post them to your Web site with minimal effort.You can also add your podcasts to the
iTunes Store, which lets you reach a huge audience worldwide.

Burn custom DVDs of your movies and photos. Despite the Internet, DVDs remain a
great way of sharing and enjoying movies and photos.iDVD gives you all the features
you need to create professional-looking DVDs with customized menu screens and com-
pelling content. And if you need to create a DVD in a hurry, you can use the Magic DVD
feature to do the grunt work for you — or use the OneStep DVD feature to burn a movie
straight to DVD from your DV camcorder. 1
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You can start playing music and videos within minutes of launching iTunes,
but to get the very best out of iTunes, you'll need to explore its advanced fea-
tures. Do you want to make sure that iTunes gives you the highest audio
quality that your Mac can deliver — and that you get the best possible sound
on your iPod as well? What about building an iTunes library that lets you
quickly find the songs you like? You'll probably want to create both unchang-
ing playlists and playlists that update themselves automatically with fresh
songs, back up your iTunes library in case disaster strikes your Mac, and use

your iPod to carry or transfer essential files as well as your songs and videos.
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Getting High-Quality Audio on iTunes
and an iPod

If you love music, you'll love the audio quality that iTunes and an iPod can deliver.But to get the very
best out of your Mac and iPod, you need to choose the right settings in iTunes and on the iPod.

Setting iTunes to deliver high audio quality

You need to do three things to set iTunes to give you high-quality audio:

@ SetiTunes to create high-quality audio files from CD
@ Choose essential playback settings in iTunes

@ Apply equalizations to your songs

Setting iTunes to create high-quality audio files from CD
Here’s how to get the best audio quality when you import songs from CD.
1. Choose iTunes > Preferences to open the Preferences dialog box.

2. Click General in the toolbar to open the General preferences (see figure 1.1).

: e
] @ B E & ) B

| General Playback Sharing Store Parental Apple TV Devices Advanced

Library Name: |21-Cuitar Salute

Show: EMt}vies EApplications
™ TV Shows # Radio
M Podcasts EParty Shuffle
1 Audiobooks ™ Ringtones
Ecenius

Source Text: | Small B List Text: | Small @

When you insert a CD: I Ask To Import CD M ( Import Settings... )

E.Mutcumaticall'”r retrieve CD track names from Internet

™ Check for new software updates automatically

(Gnee) 060

1.1 iTunes’ General preferences let you control which action iTunes takes when you insert a CD.
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Tell iTunes what to do when you put a CD in your Mac. | find that Show CD is the best

choice because it lets you fix any incorrect tag information before you import the CD.Your
alternatives are Begin Playing, Ask To Import CD (the default), Import CD, Import CD And
Eject,and Show CD.

Select the Automatically retrieve CD track names from Internet check box if you want
iTunes to download track names for you. This is the easiest way to get CD information,
but it's a good idea to check that the information is correct before you apply it.

Click the Import Settings button to display the Import Settings dialog box (see figure 1.2).

Import Settings

Import Using: | AAC Encoder |-$‘l
Setting: | Higher Quality (256 kbps) '-&ﬂ
Details

128 kbps {(mono}/256 kbps (sterec), optimized
for MMX/SSE2.

"1 Use error correction when reading Audio CDs

Use this option if you experience problems with the
audio quality from Audio CDs. This may reduce the
speed of importing.

Mote: These settings do not apply to songs
downloaded from the iTunes Store.

_ Cancel ) (@K

iTunes’ Import Settings control the quality of the music you get in iTunes

on your iMac and on your iPod or iPhone. If you want high-quality audio, you
need to change the default settings.

In the Import Using pop-up menu, choose the encoder for creating the audio files. See
the sidebar “Picking the Best Encoding for Your Needs"” for advice.

Choose a quality setting for the encoder in the Setting pop-up menu. iTunes offers pre-
set choices for all encoders except Apple Lossless Encoding.To choose custom settings, click
Custom and work in the dialog box that iTunes displays. Figure 1.3 shows the MP3 Encoder
dialog box for choosing custom settings for encoding MP3 files.

Select the Use error correction when reading Audio CDs check box if you find your
song files contain pops, skips, or dropouts caused by the drive reading them incor-
rectly, or if you simply want to be sure of getting quality audio files. Using error correc-
tion slows down the importing speed, so you may prefer to clear this check box and test
whether the song files come out clean.

Click OK to close the Import Settings dialog box, and then click OK to close the
Preferences dialog box.



MP3 Encoder

Stereo Bit Rate: [ 320 kbps Fﬁ*‘

E Use Variable Bit Rate Encoding (VER)
Quality: | Highest H‘a-q

(With VBR enabled, bit rate settings are used for a guaranteed minimum bit rate.}

Sample Rate: | Auto HA
Channels: | Auto l~$-!
Stereo Mode: | Normal [

ESmart Encoding Adjustments

M Filter Frequencies Below 10 Hz

(" Use Default Settings\_ (" Cancel ) ( oK~ )

1.3 Custom dialog boxes such as the MP3 Encoder dialog box let you choose exactly
the encoding settings you want.

Choosing essential playback settings in iTunes
Your next step is to choose three settings that make a huge difference to how iTunes plays back
the songs. Follow these steps:

1. ChooseiTunes > Preferences to open the Preferences dialog box.
2. Click the Playback button to display the Playback preferences (see figure 1.4).

3. Select the Crossfade Playback check box only if you want to use the cross-fading fea-
ture. This fades from the end of one song to the beginning of the next.If you use this fea-
ture, drag the slider to set the number of seconds (from 1 to 12), depending on how much of
each song you want to lose.

4. Select the Sound Enhancer check box if you want to use Sound Enhancer. This feature
performs several audio tricks, such as increasing the stereo separation of the left and right
tracks and adding harmonics. Sound Enhancer can make music sound more lively, but at the
cost of authenticity. If you use this feature, drag the slider to set the degree of enhancement.

5. Select the Sound Check check box if you want iTunes to normalize your songs.
Normalization involves evaluating the songs in your library for loud and quiet points and
reducing the difference between the two.This helps to avoid getting your ears blasted by a
loud song that follows a quiet one, but it makes the music much less dynamic and compelling.



ever used a Loudness button on an old stereo, you may see a similarity between that
and Sound Enhancer. But where most Loudness features could only be either on or
off, you can adjust the amount of difference the Sound Enhancer makes by dragging
its slider.

6. Click OK to close the Preferences dialog box. Test the settings you've chosen by playing
various types of songs,and change the settings if you don't like the results.

Ceneral %@aﬂk Sharing Store  Parental Apple Tv  Dewices  Advanced

[l Crossfade Songs: C

M Sound Enhancer: v,

"1 Sound Check

Automartically adjusts song playback volume to the same level.

Play Movies and TV Shows: [ in a separate window

Audio Language: | English

B
Play Music Videos: | in a separate window A
B
B

Subtitle Language: | Off

"1 Play videos using standard definition version
[T Show closed captioning when available

1.4 In the Playback preferences, choose whether to crossfade playback, use
Sound Enhancer, and use Sound Check.

i

[Tl Punch to penetrate our cluttered consciousness on the radio or in public, sound

as the sound engineer has given them. Unfortunately, to pack songs with enough

engineers all too often now compress the dynamic range, which makes the music

seem louder overall but removes the difference between the “loud”and “quiet” parts.




CDs contain music files in an uncompressed format designed for use on CDs. To copy the
songs from CDs to your Mac, you use an encoder to convert the files to a format suitable for
computers. iTunes comes with five encoders, so you can pick the one that's right for your
needs. For some of these encoders, you can also adjust the quality setting, or bitrate, which
also affects the file size.

iTunes comes set to import songs from CD using the Advanced Audio Coding (AAC)
encoder at the 128 Kbps bitrate. This is good for general-purpose recording with modest
file sizes, but if you want high audio quality, either choose the Higher Quality (256 Kbps)
setting, or use the Custom dialog box to set the highest available bitrate, 320 Kbps.

If you use @ Mac and an iPod or iPhone, AAC is usually the best format to choose. iTunes,
iPods, and iPhones can play AAC files, but most other hardware and software players
can't. If you need to play your song files on other players, use the MP3 format instead.
MP3 has lower quality than AAC at the same bitrate, so choose at least the Higher
Quality (192 Kbps) bitrate for MP3. For best results, use the Custom dialog box to set the
highest available bitrate, 320 Kbps.

If you have lots of hard disk space on your Mac and want superior audio quality, try the
Apple Lossless Encoding encoder. Lossless means that, unlike the AAC and MP3
encoders, Apple Lossless Encoding does not discard any of the data contained in the
original music — so the song file should be perfect. Apple Lossless Encoding files take up
much more space than AAC and MP3 files, so they’re not great for iPods and the iPhone.
In fact, the iPod shuffle can’t even play Apple Lossless Encoding files.

Your last two choices of encoder are WAV and AIFF. These are essentially the same thing:

uncompressed audio data, but with different instructions at the beginning of the file. WAV
and AIFF both give perfect audio quality but lack the tag information that portable music
players need; besides, WAV and AIFF files are so large that few will fit on any but the
most capacious portable players.

Applying an equalization to the music you're playing

Your third move toward making songs sound the way you like them is to use the Equalizer. You can
either apply an equalization to the music as you listen, just as you might do with a graphical equalizer
on a stereo or boom-box, or apply an equalization to any song in your library (see the next section).



iTunes’' Equalizer is easy to use.These are the moves you need to know:

@ Choose Window > Equalizer or press 8+Option+2 to toggle the display of the Equalizer

(see figure 1.5).

1.5 Use the Equalizer to make songs sound the way you like them.

@ Select the On check box to turn the

Equalizer on,and then choose the equal-
ization you want from the pop-up menu.

To create a custom equalization, drag
the frequency sliders to produce the
sound you want. If you want to boost
the amplification, drag the Preamp slider
up; to reduce the amplification, drag the
slider down.Open the pop-up menu,
choose Make Preset, type the name in
the Make Preset dialog box (see figure
1.6),and then click OK.

To rename or delete an equalization,
open the pop-up menu and choose Edit
Presets. In the Edit Presets dialog box
(see figure 1.7), select the equalization,
and then click Rename (to rename it) or
Delete (to delete it). Click Done when

you're ready to close the dialog box.

New Preset Name:

I Psychedelic| I

() )

1.6 You can easily create a custom preset to
apply an equalization.

Latin |4 [ Rename... )
Loudness
Lounge

Piano

Pop |
Psychedelic

R&B

Rock

Small Speakers

Spoken Word

Treble Booster

Treble Reducer

Vocal Booster v m

1.7 Use the Edit Presets dialog to rename a pre-
set or delete it.
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|' Jl ustom equalizations don't carry t

these devices, it's best to experiment with iTunes’ built-in equalizations before creat-

Note ing your own.

Applying an equalization to a particular song

Applying an equalization as you're listening works well, but what's much handier is applying an
equalization to each song in your library. This way, whenever you play the song, iTunes uses that
equalization automatically. So does your iPod or iPhone (as long as the equalization you choose is
one of the built-in ones).

You can apply an equalization to any song in your library in one of these ways:

@ Single song. Ctrl+click or right-click the song, choose Get Info, and then click the
Options tab of the Item Info dialog box (see figure 1.8). Open the Equalizer Preset pop-up

menu, choose the equalization, and then click OK.

—{ Summary Info  Video Sorting | Options @ Lyrics  Artwork 1—

Volume Adjustment: $
-100% None +100%

Equalizer Preset; v None

Media Kin
Bass Booster
Fitin Bass !led ucer
Classical
Dance
[1Start Time; Deep
Electronic
[ Stop Time! Elat
Heavy
"1 Remember Hip-Hop
["1Skip when|  Jazz
[Partofag Latin
Loudness
Lounge
“ &
T

Chrovioss ) (o) 0

1.8 Choosing an equalization for a single song in the Item Info dialog box.

@ Single song. Add the Equalizer column to the current view by Ctrl+clicking or right-
clicking an empty column heading (after the last column) and choosing Equalizer from
the menu. (You can also replace an existing column by Ctrl+clicking or right-clicking its
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column heading and then choosing Equalizer.) You can then apply an equalization to a

song by using the pop-up menu as shown in figure 1.9.

50 sangs

Eased On' Born Sandy Devotional by Triffids Limit to: i Refresh | Sawe Playlist |
Jd Music A Name ___ Tme Amist | Equalizer |
B Movies 1 # Bom Sandy Devotional 355 Triffids [+] Rock
&7 Shaws 2 @ IKeepa Close iatch 330 John Cale + None
P Fodeasts 3 Charlotte Street 355 Uoyd Cole & The Com... |
@ Avplicai 4§ Are You Experienced 447 Patti Smith
ST 5 The Unguarded Mom ent 413 Church Bass Booster
‘L Radio 6 @ Primary 335 Cure Bass Reducer
L. Ringtones 7 A Perfect Day, Elise =07 B Harvey Classical
STORE 8 : :arsnn?’:f:hm“g; ;2; JTI’IffIdS - - Dance
= appy When It Rains. 137 Jesus and Mary Chain
I iTunes store Union City Blue 320 Blondie geep :
[8 Purchased # The Etan Rifles 404 Jam REROTE
ey 12 Lowe Like Blood 426 Killing Joke ;\:;
& Pany Shufme 13 @ Pioneer tothe Falls. 542 Irtemol Ay
e 14 @ Goodnight Bad Morning 352 Kills Hip-Hop
. " 15 @ Kingdom of Doom 243 Cood, the Bad, and th Jazz
¥ [ Artist Playlists 16 @ Starsfur 46 Sigur Rds Latia
* [ Exercise Playlists 17 OneSoul Less on Your Fiery . 442 Triffids Loudness
» [ General Playlists 18 Logic 449 Sisters of Mercy Lounge
{8 On-the-Go Folder 15 @ Sound and Visian 303 Dawid Bowie Blasa
i 0 WA Fores 455 Cure
» (] Playlists for Restin 5
& piy 9 2 o Are vou Ready to Be Heartbr 306 Uoyd Cole & The Com Pop
A Cerius - PrenShew |0y g gig o 400 House of Love PowerBass
# CenlusTry 1 23 ® Down in the Tube Station at 405 Jam Psychedelic
[ Latest Additions 24 @ Tender |s the Night {The Lon. 344 Triffids R&B
Hesier Played 25 @ Heart and Soul 549 Joy Diwision Rock
[8 Play Count 151 26 W | Wish | Could Have Loved Yo... 233 Candie Payre Small Speakers
G 27 @ Running the Warld £47 Jawis Cacker Spoken Word
; 8 @ Denis 218 Blondie Tidbh Bty
Top 2S0MostRIaved | | 2g g fgrael 456 Siouxsie and The Ban. . bia Fiod
%) Top 251-1000Mos... | |30 @ ForEmma 41 Bon lver Treble Reducer
s Ton 1000 MostPlav.. Y131 © Good Fortun 120 Pl Hary Vocal Booster

(&

1.9 Add the Equalizer column to a view to give yourself the easiest way to
apply an equalization to a song.

@ Multiple songs, an album, or all an artist’s songs. Select the songs or the album,
Ctrl+click or right-click, and choose Get Info to open the Multiple Item Information dia-
log box. For an artist, click the artist,and then press 8+ to open the Multiple Item
Information dialog box. Click the Options tab, open the Equalizer Preset pop-up menu,
choose the equalization, and then click OK.

to, the type of speakers or headphones you use, and the state of your ears, not to

mention your personal preferences. Bear in mind that the names of the built-in

Genius
equalizations are merely suggestions — so if you find you like to listen to speed

metal using the Jazz equalization, feel free to do so.

Choosing suitable iPod settings

To get the highest audio quality on your iPod, you need to load high-quality songs, such as those
you've ripped from your CDs as discussed earlier in this chapter. You need to turn off the Sound
Check feature on your iPod (or iPhone) to prevent it from normalizing the sound. You may also
need to apply equalizations on the iPod.

11
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audio quality by buying higher-quality headphones that you find comfortable. If

you're thinking of upgrading your headphones, also look into buying a headphone
amplifier because this can greatly improve the sound you get out of your iPod or
iPhone.

Turning off Sound Check on the iPod or iPhone
If you want songs to sound good on your iPod or iPhone, turn off the Sound Check feature to pre-
vent the player from robbing the songs of dynamic range by normalizing the sound.

Here’s how to turn off Sound Check on the various models of iPod and on the iPhone:

@ Sixth-generation iPod or iPod nano. Choose Main menu => Settings = Sound Check,
and then press the Select button to switch between On and Off.

@ iPod shuffle. Connect the iPod shuffle to your Mac, then click it in the Devices category
in the Source list to display its control screens. On the Settings tab, clear the Enable
Sound Check check box, and then click Apply.

@ iPod touch. Press Home, touch Settings, touch Music, and then touch the Sound Check
slider to move it to the On position or the Off position.

@ iPhone. Press Home, touch Settings, touch iPod, and then touch the Sound Check slider
to move it to the On position or the Off position.

Applying equalizations on the iPod or iPhone
If you've applied one of iTunes’built-in equalizations to each song, as discussed earlier in this chap-
ter,your iPod or iPhone automatically applies those equalizations when you listen to the songs.

To keep audio quality high on the iPod shuffle, clear the Convert higher bit rate songs to
128 Kbps AAC check box in the Options area of the iPod’s Settings tab. Converting
songs to 128 Kbps AAC reduces the amount of space the songs take up, but it costs you
audio quality. You lose even more quality if the song you're converting was encoded

using an encoder other than AAC (for example, MP3). The conversion also makes syn-

chronization take longer, which is seldom welcome.

12



When you've applied a custom equalization to a song, however, you'll find that it's not available on

your iPod. In this case, you can change the equalization on the iPod or iPhone manually. You may
also need to do this for songs whose equalizations are available, simply because songs sound dif-
ferently through headphones than through your Mac’s sound system.

Here's how to apply an equalization on the iPod or iPhone:

@ Sixth-generation iPod or iPod nano. Choose Main menu = Settings = EQ. Scroll to the
equalization you want, and then press the Select button.

@ iPod touch. Press Home, touch Settings, touch Music,and then touch EQ.On the EQ
screen, touch the equalization you want, and then touch Music to return to the Music
screen.

@ iPhone. Press Home, touch Settings, touch iPod, and then touch EQ.On the EQ screen,
touch the equalization you want, and then touch iPod to return to the iPod screen.

Building a Powerful, Easy-to-Use
Library

To make your iTunes library as powerful and easy-to-use as possible, store it in a folder that has
plenty of space, and make sure that folder contains the file for each song in the library. For faster
searching and enjoyable playlists, tag the files with accurate information, rate the songs so that
iTunes knows which you like, and trim off any unwanted parts of songs.

Normally, you'll want to store all your songs in a single library so that you can play them easily. But
if need be, you can create multiple iTunes libraries, each containing a different collection of songs.

Choosing where to store your library

iTunes normally comes set to handle your library like this:

®

Put all your music and video files in the same folder within your Home folder.

®

Keep the folder organized by artist folder, album folder, track number, and track title —
for example, /Bruce Springsteen/Greatest Hits/01 Born to Run.m4a. (If there’s a disk num-
ber, such as Disk 1 of 2, iTunes includes that too.)

®

Make a copy of each file you add to the library from another folder, instead of linking to
the file in that folder.

13



This behavior is convenient for many people, but if you have a large iTunes library or your Mac has a
small hard disk, you may run short of space.You may also want to store your iTunes library in a differ-
ent folder so that you (or others) can access the media files from other computers on your network.

Here's how to check and change where iTunes is storing your library and choose other key settings.

1. ChooseiTunes => Preferences and then click the Advanced button to display the
Advanced preferences (see figure 1.10).

Advanced

HMG‘)@[’—E.& L B g

Ceneral Playback Sharing Store  Parental Apple T Devices  Advanced

iTunes Music folder location
Macintosh HD:Users:guy:Music:iTunes:iTunes Music: | ChanQE--- /

Resat )

E Keep iTunes Music folder organized
Places files into album and artist folders, and names the files based on
the disc number, track number, and the song title.

™ Copy files to iTunes Music folder when adding to library

Streaming Buffer Size: | Medium |~$3

Use iTunes for Internet playback: [ Set

Reset all dialog warnings: [ Reset |

M Keep MiniPlayer on top of all other windows
E Keep movie window on top of all other windows
| Display visualizer full screen

E Group compilations when browsing

( Cancel ) Bk

1.10 Use the Advanced preferences to choose where to store your library.

2. Look at the iTunes Music folder location box to see which folder iTunes is storing your
music in. If you want to change the folder, click the Change button, select the new folder in
the Change Music Folder Location dialog box, and then click Open.

3. Select the Keep iTunes Music folder organized check box if you want iTunes to organ-
ize the folder and filenames. This setting is usually helpful, but it does mean that when
you change a tag such as a song name, iTunes changes the filename to match as well.

14



4. Select the Copy files to iTunes Music folder when adding to library check box if you

want iTunes to copy each file you add from another folder. If you want iTunes to create a

link to the file in that folder instead, clear this check box.

5. Click OK to close the Preferences dialog box.

Getting all your media files in the same folder

If you want to be able to back up your iTunes library in a single action, use the Consolidate Library

command to make sure all your media files are stored in the same folder.

e ] Plenty of space to hold all the files. The easiest way to see how much space your

iTunes library takes up is to click the Music item in the Source list, click All in the
Artists list and the Album list, and then look at the readout at the bottom of the
iTunes window. Repeat the process for Movies, TV Shows, and any other items that

appear in the Source list,and then add the figures together.

When you give this command, iTunes copies any files that are stored outside your iTunes Music

folder into the iTunes Music folder.Normally, it’s a good idea to select the Keep iTunes Music folder

organized check box in the Advanced preferences before you consolidate your library, allowing

iTunes to rename folders and files and generally keep your library straight.

After this preparation, consolidating your library is easy, but copying the files may take some time.

Follow these steps:

1. Choose File => Library o> Consolidate
Library. iTunes displays the message
box shown in figure 1.11.

2. Click Consolidate. iTunes copies those
files that are located outside your iTunes
Music folder into the folder. If you've
selected the Keep iTunes Music folder
organized check box, iTunes renames
files whose names differ from their tag
information.

& Consolidating your library will copy all of your music inta
h | the iTunes Music folder.
This cannot be undone.

1.11 iTunes double-checks that you want to
consolidate your iTunes library because there’s
no easy way to undo a consolidation.
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Tagging songs after adding them to your library

After you've added a song to your library, you can easily change its existing tags or add missing tag
information.

If you need to change a tag that’s displayed in whichever iTunes view you're using, you can simply
edititin place like this.

1. Click once to select the song.

2. After a short pause, click again to put an edit box around the field (see figure 1.12). If
you don't pause between the clicks, iTunes registers a double-click and starts playing the
song.

® Don't You (Forget Abo... 421 simple Minds dlittering Prize 11/137/2005 8:57 AM
™ Leilani 303 Game Theory Tinker 1o Bvers 1o Chance 11/9f2005 2:04 PM

™ Creeping Death 508 Apocalyptica Plays Metallica By Four Cellos 11716742005 4:50 PM

® Too Little Too Late 422 Metric Live It Qut Ti18/2006 3:53 PM
® Cadillac Caming 435 James Ray Best 171372006 12:37 PM

1.12 The quickest way to edit a single tag is to open an edit box in the iTunes list.

3. Click to position the insertion point, type the change, and then press Return to apply
the change.

. /] Genre pop-up menu and choose Custom, or simply drag across whichever genre is
I currently displayed to select the text. Type the name of the genre you want to create.

You'll then be able to use this genre for other songs too.

To change several tags on a single song, use the Item Information dialog box like this:

1. Ctrl+click or right-click the song and choose Get Info to open the Item Information
dialog box.

2. Click the tab that contains the tags or settings you want to change. For example, to con-
trol how iTunes sorts the songs, click the Sorting tab (see figure 1.13) and use the boxes on it.

Select the Gapless Album check box if you want to mark the songs as being gapless.

This setting turns off cross-fading and is good for live albums, classical music, and
spoken-word audio.

16



[ Summary Info  Video | Serting = Options  Lyrics  Artwork ]

Name Sort Name

Fortune Teller

Artist Sort Artist
Robert Plant and Alison Krauss [Robert Plant ]
Album Artist Sort Album Artist

Robert Plant and Alison Krauss

Album Sort Album
Raising Sand

Composer Sort Composer
Show Sort Show

(" Previous ) ( Next ) [ Cancel | @

1.13 The Sorting tab of the Item Information dialog box lets you add extra information

for sorting without changing the tags that appear in the iTunes interface.

3. When you finish changing the tags and settings, click OK.

Understanding the less obvious tags

Most of the tag fields, such as Name and Artist, are easy to grasp. Here's a quick run-down of the
more puzzling ones:

@ Album Artist. The artist name that you want to use for the album, where it’s different
from the artist name for the song. For example, you might use Various Artists as the
album artist for a compilation aloum.

@ Grouping. This tag lets you group the movements in a classical music work, but you can
use it for other purposes too. For example, instead of creating a Psychedelic Rock genre,
use the Rock genre and put Psychedelic in the Grouping tag; or add Grouping tags such
as Party or Workout to songs of different genres so that you can pick them out across dif-
ferent genres.

@ BPM. Beats per minute — the tempo of the song.

17
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out the beats per minute of songs and adad this Info to the tags, use a too

such as Tangerine from Potion Factory (www.potionfactory.com/tangerine/) or

beaTunes (www.beatunes.com).

@ Sorttags (Sort Name, Sort Artist, Sort Album Artist, Sort Album, Sort Composer, and
Sort Show). These let you control how iTunes sorts songs (and shows) without changing
the information iTunes displays. For example, you may want to sort your Beethoven
music by “Beethoven”rather than by the names of the various orchestras and conduc-
tors. By adding Beethoven to the Sort Artist tag, you can do so.

To change one or more tags on multiple songs at once, use the Multiple Item Information dialog
box like this:

1. Select the songs whose tags you want to change. For example, click the first song, then
88+click each of the other songs.

2. Ctrl+click or right-click in the selection and choose Get Info to open the Multiple Item

Information dialog box (see figure 1.14).

[CInfo | Video  Sortin Options |
4 d 9 P J

Artist Year
a| | #2007 |
Album Artist Track Number
=] O] lefO] |
Album Disc Number
O =/ =
Grouping BPM
0] O]
Composer : :Arlwork
0
Comments
- 10
]
Genre lianing
] Alternative & Punk [ ™| wwxww

(Conee) (06

1.14 Use the Multiple Item Information dialog box to change shared tag
information on several songs at once.
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3. Change the tags that apply to all the songs you selected, and then click OK. When you

change a tag, iTunes selects the check box next to it so that you can easily track the changes
you've made.

-

to the Artwork box on the Info tab in the Multiple Item Information dialog box.

Note Amazon.com includes cover pictures for many CDs, but you can also add your own

pictures if you prefer.

If you want to apply tags to your songs automatically, visit the Doug’s AppleScripts

for iTunes Web site (http://dougscripts.com/itunes/) and look through the Managing

Track Info scripts.

Trimming off unwanted parts of songs

Do you ever find yourself always skipping the beginning or end of a song? If so, don't suffer

through it — use this trick to trim off the unwanted part of the song.

. Play the song, and note the time at which you want the song to start or stop.

. Ctrl+click or right-click the song and choose Get Info to open the Item Information
dialog box, and then click the Options tab (see figure 1.15).

. Click in the Start Time box or the Stop Time box, and then type the time you want the
song to start or stop. Use the format minutes:seconds.thousandths — for example, 3:24.000.
Note that it's a period between the seconds and thousandths, not a second colon.

. Click OK to close the dialog box.

. Play the song again and make sure the cutoff is right. If not, open the Item Information
dialog box again and adjust it.

. Right-click the song and choose Create Format Version. (Format here is the encoding for-
mat you've chosen in iTunes — for example, Create AAC Version.) iTunes creates a new ver-
sion of the file minus the parts you chose to exclude.

. If you want, remove the original song file from your iTunes library, leaving the new
file.
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~— ! Summary Info  Video Sorting | Options Lyrics Artwork |

Volume Adj ant: 9
-100%

Equalizer Preset: | Psychedelic 9

Rating: | *kkk

[ Start Time: 0:00

[ |Stop Time: 2:24.784

"1 Remember playback position
"1 Skip when shuffling

"1 Part of a gapless album

’fPrevioust\ (" Next \1 E

1.15 On the Options tab of the Item Information dialog box, you can set the
start time or end time for a song. You can then trim the song file to use this

start time or end time.

can be useful when you've recorded a live performance and want to keep only parts

enlu of it. First, create a duplicate copy of the song. The easiest way to do this is to

Ctrl+click or right-click the song, choose Show In Finder, press 8+D to duplicate the

song file,and then drag the duplicate to your iTunes library.In iTunes, trim off the first
part of the song from one file, leaving the second part, and then trim off the second

part of the song from the other file, leaving the first part.

Separating your music with multiple iTunes
libraries

Normally, iTunes puts all your songs into a single library. But here’s a neat feature: You can create
separate music libraries if you want. For example, you may prefer to keep your classical music sep-
arate from your popular music, put a library on an external drive to save space on your Mac’s hard
drive, or maintain a family-friendly library as well as one that includes harder-edged material.
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